www.atari-history.com

Contents

1 Introduction to GEM RCS
What Are Resources? ... ...... .. .00 . .. .. ..
GEM RCS Screen. .. ... ... ... ... .... e
Menu Bar . . . . ... e e e
TitleBar. .. . ............ G TR
- Close Box. . .. .......... e [P
TOOIKIt . o o e e
CooVMiew WIndow . ... e
Parts BOX . . . . .o oo e
Scroll Bars and Shiders . . . ... ............ e
Mouse TechnigQues. . . . .. . . . ...
Sizing Objects . ... ... .. U
Deleting Trees or Objects. . .. ... ... ... ..... .
Workspace and Mamory Use . . . . .............. Y

2 GEM RCS Tutorial

Starting GEM RCS ... . . ... . e

Creating a8 MeNuU . ... ... ... .. ..
Choosing and Naming a MENU Object Tree lcon . . ..
Opening the Object Tree . ... ............... ...
Adding a Menu Title. . . .. ... .. L o oo
Adding Entries tothe Menu . . . ... ... ...........
Editing the Entries . . . ... ... ... ... ..o
Sizing the Menu Box . ... ... ... ... ... ...
Sizing the Commands. . . . ... ......... ... .....
Extending the Separator Line . . .. ..............
Sorting the Objects in the Menu. . .. .............
Closing the MENU Object Tree. ... ..............

Creating a Dialog BOX . . .. ... ... . iiu.nn
Choosing and Naming a DIALOG Object Tree Icon . ..
Opening the Object Tree . . . . ................. .
Choosing Objects for Your Dialog Box . ...........

1 | 1 1 1

N MM NN T g L
i ¥ [ ] Vool 1 1 | | | t | 1
W W R - - OO @~ OO W, b

(SR SR SR SR U G SR S
\
OO ~N~N~NODO;M b A

s




Contents -

Customizing the STRING Object . . . . .
Customizing the BUTTON Object . . ..
Setting a Radio Button. . . .. . ......
Creating Additional Radio Buttons . . .

Creating Exit Buttons . . ... .. ......
Resizing the Background of Your Dialog Box . ... ... '
Sorting Objects in the Dialog. .. .. ..
Closing the DIALOG Object Tree. . . ..
Saving_a Resource File. . ............
Quitting GEM RCS ... ........ ... ..

3 GEM ~'Rd‘éj-neterenc,é

Aspect Ratio:and :Screen Resolution. . . .
File and Desk'Menus . ..............
"FileMenu.......... e e
Desk Menu. ... .............c...s
Using the Parts Box. . . .............
MENU Tree Objects ... ...........

DIALOG Tree and PANEL Tree Objects

ALERT Tree Objects . . . ...........
FREE Tree Chjects ... .........-. .
Object Classes. . . ............ ...

............

............

P N T I v, L.

------------

............

............

............

............

............

------------

Unformatted Strings and Formatted Text . .........

Adding Objects to Trees . ...........

Moving, Copying, and Deleting Objects .

Sizing Objects . . . ... ... ... .......

------------

------------

Maintaining the Parent-Child Size Relationship........

icons and BitImages . .. .......... ...
Loading lcons. . . . .. .
Loading Bit Images. .. ............
Using FREE Trees. .. .......... P
Free-5String Objects . . ............

FREE image Objects . . . ...........
Using the Object Editing Dialogs . . . . ..
Edit Unformatted String Objegt Dialog

iv

------------

............

------------

............

............

............

(M ]
|

3-

1
3
=3
3
4

AL ES
CdNNOO LA

|wt1:w

[
—
- O

3-1
3-12
3-12
3-13
3-13
3-13
3-14
3-14
3-15




! Contents
B S IR o
Edit Box Type Object Dialog. .. = S E2 |- EE
Edit Formatied Text Object Dialoy I SR L
Edit Bit Image Object Diaslog. ... . ... ..... L3160 e
Edit Icon Object Dialog. . . ... e £ L I RO
Using the Clipboard. . ... . . o B e Sl
Using the Toolkit. ... /.. .. o0% Ty el ot ponie 0 3-18
Descriptions of the Tools. . ... . [ 75,07 .. ... 710 3-18
GEM RCS Menu Commands . ... ... ......... ... 3-23
File Menu. .. ... ...... . T . A 3-23
Global Menu. . . ... .. e e T i - . 3-2%
= Edit Menu. . . .. .. .o oL e e e 3-27
RETIE Options Menu. . . . . .. B A S R ST T A .- 3-28
K ; R ngl’ﬂl’chv MeEnu . . .. L v e b e e e s s e L, 3‘29
"RES Menu . ... ... ... I PR . 3-30
Kevstroke Equwalents of Menu Commands N 3-30
- 4 RSCREATE and Other Technical lnformauon ' _
‘ . Using RSCREATE . . . .. ... ... . .. e 4-1
RSH File. .. ... e e 4-1
Hand-Edited Rasource Fites . ... . ............... 4-1
Porting Resource Files . . . . . [ 4-2
Compiler Notes . .. ...... ... . ..o, 4-3
Chaining Resources . . . ....... e e 4-3
Unknown Object Tree Types . ... . ... .. .. .ot nn. 4-3
Arranging and Aligning Objects . . . .. .............. 4-4
Creating a Library Fite . . ... ........ [P . 4-5
Figures ' .
1-1 GEM RCS SCreen . .......o v vireannenacnson- 1-4
Tables .
1-1 GEM RCS Mouse Techniques .. ... e 1-7
3-1 Screen Resolution and Aspect Ratio ............ 3-1
3-2 Object Classes. . . .......c. ..o iennnnnnn-. 3-8
3-3 Unformatted Strings and Formatted Text .. ...... 3-9
3-4 Keystroke Equivalents of Menu Commands. . . .. .. -




Section 1

Introduction to GEM RCS

‘.n’_‘,".( i

REETRY
T4

. i R
GEM™™ Resource Construction Set (RCS) is a GEM appliration‘\vou use
to create resources {menus, dialog boxes, alert boxes, etc.) for your
GEM application programs. GEM RCS aiso lets you incorporate icons
and bit-images you create with GEM IconEdit into your resource files.

You don‘t have to be a programmer to use GEM RCS. You can create
all ol the application’s resources and then give the file to a
programmer to. inci'u'de with the program code.

This documem is - div;ded into the following sections:

. Sectlon 1, |ntroduction to GEM RCS. explains what a resource is,
descrlbas the GEM RCS screen, discusses the mouse techniques you
use with GEM RCS, and describes the GEM RCS workspace snd how -
GEM RCS uses memory.

® Section 2, GEM RCS Tutorial, acquaints you with basic terminclogy
and techniques as you construct a menu and a dialog box.

® Section 3, GEM RCS Reference, contains detailed descriptions of
GEM RCS's features, including the parts box, the objects you can
use in your resources, the clipboard, tooclkit, and menus.

® Section 4, RSCREATE and Other Technical Information, describes
RSCREATE, a utility program with which you can modify and port
resource files. The section also describes how to chain resource
files and how to deal with unknown object tree types, and provides
some tips for speedy and efficient use of GEM RCS.

Manv of the techniques you use with GEM RCS, such as choosing 8
command from a drop-down menu, are the same as those you use
with the GEM Desktop™. Be sure you have read your GEM Desktop
guide and understand these basic operations before you start working
with GEM RCS.

1-1
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What Are Rasources? GEM Resource Constru‘ction' Set

WHAT ARE RESOURCES?

i
In GEM applications, resources are lhmgs lhal appear on the screen
(like menus, dialogs, or alerls) that are not actuallv part of the program -
code. Instead, resources are kept in a separate resource hie. an’
arrangement that has several advamages

vf

® As noted previously, the resource flle can be created by a non-
programm--. -

® Tha resource file can be modified or updated' {again by a non-
programmer) often without the application code having to be
recomplled

e An appllcaupn can exist in different national “editions.” using the

, same program code and different resource files for each nationality.

® An appilcatlon can operate in -different machine environments, using

resources generated from the same source code.

Resources are made up of objects. “Object” in this sense, is a
technical term referring to a specific set of images that can appear on
the screen, including empty boxes boxes comammg text. text strings,
and the like.

To create a resource--a menu, for example--you combine objects to
form an “object tree.” The relationship between the objects in the tree
is described in family terss: the first object is the “parent”; the objects
contained within the parant are the “children.”

For a complete description of objects and cbject trees, see Section 6.
“Object Library,” in .the GEM _ Application Environment Services
Reference Guide. (The GEM Application Environment Sarvices are
referred to as GEM AES))

Using GEM RCS, you can create the following kinds of object trees:

MENU The drop-down menus characteristic of GEM applications
are contained in the resource file. No menu can be
more than one-fourth the size of the screen. This
makes it possible for the part of the screen covered by
the menu to be written toc a special buffer (see the
discussion of the menu/atert huffer in the introduction 19

1
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GEM Resource Construction Set 4 What Are Resources?

DIALOG

PANEL

ALERT

FREE.

GEM Programming) and for the screen to be redrawn by

“the GEM AES from this buifer. A screen redraw from Lhe

menu/alert buffer is faster than a redraw handled by the
application. .

To the end-user, a dialog is a GEM application’s means
of providing or getting information, but GEM applications
can use dialogs for other purposes. For example, the
GEM RCS toolkit (see Figure 1-1} is actually a DIALOG in
tha resource file‘.

Dialogs do not use the menu/alert buffer and thus can
be larger than one-fourth the size of the screen. The
objects in a dialog "snap” to character boundaries on the
screen; this snap makes it easier to align the elements
of the dialog. ' '

A panel is similar to a dialog. except that it does not
have the automatic character boundary snap. A panel
can be used for anything that requires precise
positioning of objects. For example, the GEM RCS parts
boxes (see Figure 1-1) are panels in the resource fila.

Alerts (a specialized subset of dialogs) are 2 GEM
application’s means of displaying notices, warnings, or
aerror messages. Alerts have a fixed format and a size
limit of no more than one-fourth the size of the screen.
(They use the menu/alert buffer mentioned previously.)
The alert format includes an icon, a 200~character ASCI
text string (five lines of no more than forty characters
each), and up to three exit buttons. Each exit button has
a twenty-character maximum.

This category includes strings and bit-images you want
to include in the application, but not as part of the code.
in this way, you can change the string or bit-image
without having to change the code and recompile.

One example of a free string is the non-default state of
a context-sensitive menu command. For example, GEM
RCS’s Globa! Menu has a command whose default state
is Hide Parts. The default version of the menu is
contained in the MENU tree; the non-default state of the
command (Show Parts) is stored as a free string.

1-3




GEM RCS .Screen GEM Resource Construction Set

GEM RCS SCREEN

When you start GEM RCS, your screen looks like the illustration below.
The labeled components are described after the iliustration.

close box menu har htle bar

l’File Global Edit Optiens Hierarchvl RCS
C:UNTITLED.RSC

4

oIaLoG| Sieeis =3 —)

s | [0 - —pRZLIl

S PaNEL  ALERY  FREE
4 i
Y
toolkit paris box view window scroll arrows/bar
slider

Figure t-1. GEM RCS Screen
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GEM Resource Construction Set " GEM RCS Screen

Menu Bar

The menu bar is the top line of your screen. It contains the menu
titles File, Global, Edit, Options, Hierarchy, and RCS

when you touch a menu title with the pointer, the menu drops down
below the menu bar. You can then choose a command by clicking on
its name in the menu. '

GEM RCS’s menu commands are described in detail 1n Section 3. Most
of the commands can aiso be executed by typing one of the keystroke
cambinations listed in Table 3-4. '

Title Bar
The title bar shows which of GEM RCS's two levels you're waorking in:

® root level
® object level

The root level is the highest level of the resource file. At this level,
the title bar identifies the current directory path and the resource
filename--CATOOLS\MYAPP.RSC, for example--and the view window
contains the icons for_the object trees (MENU, DIALOG, etc.) you have
placed in the resource file.

The object level is the level at which you actually work on the objects
in a tree--for example, adding text strings. command entries, oOf exit
buttons. At this level, the title bar contains the tree’s name
(FILEMENU, for example). without any directory path information.

Note the following about the name of your resource file:

® Each resource file starts out as UNTITLED.RSC until you save it and
give it a name.

® The resource file extension is .RSC (resource). Don't contuse it with
the application’s name: GEM RCS (Resource Construction Set).

1-5
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Close Box
Clicking on the close box does the following:

® It you are at the object level, the close box closes the ob|erl and
returns you to the root level of the resource file.

® if you are at the root level, the close box closes the resource file. If
you have edited the file but not saved the edits, GEM RCS displays a
dialog asking if you want to abandon the edits or save the file.

Note: if you are working on a new file that hasn't yet been named and
saved, the close box has no effect at the root level.

The close box and the Close command on the File Menu can be used
interchangeably.

Toolkit |

The toolkit (described in detail in Section 3} contains icons for the
various tools you can use 1o “customize” the objects in a tree. For
example, you can change an object's color, fill pattern, or alignment
with the tools.

View Window

The view window is where you design the tayout of a tree and
customize its objects.

Parts Box

The parts box (described in detail in Section 3) contains icons for the
objects you can include in an object tree. The contents of the parts
box change according to the type of tree you're working on.

Scroil Bars and Sliders

GEM RCS's scroll bars and siiders work in the same manner as the
scroll bars and sliders on GEM Desktop windows. Note that in most
cases you can scroll horizontally as well as vertically.




GEM Resotrce Construction Set Mouse Techniques

MOUSE TECHNIQUES

Many mouse techniques you use with GEM RCS, such as clicking and
dragging, are the same as those you use with the GEM Desktop and
other GEM applications. However, the effects of these techniques are
often specific to GEM RCS, as the foliowing table itfustrates:

Table 1-1 GEM RCS Mouse Techniques

Technique _ Effect

click 'Selects tree or object. GEM RCS indicates a
. selected tree by highlighting its icon in reverse
video and a selected object by defining its
“extent” with a dotted line.

Shift-click Selects more than one object.

Ctri-click Selects parent of object.

double~-click Opens tree or object for editing.

drag Copies tree or object from parts box to view

window: moves tree or object inside view
window: moves tree or object to or from

clipboard.
Ctri-drag Moves object’'s parent and all that parent’s
: children.
Shift-drag Copies tree or object inside view window;
copies tree or object to or from clipboard.
Ctrl-Shift-drag ‘Copies object's parent and ali that parent's
children.

Note: When using any of the dragging technigues to move or COpPY
trees or objects, remember the following:

® It you are copying from the parts box or if you are moving or

1-7
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copying within the view window, the dotted line extent of the tree
or object must be entirely inside the view window or a parent
object. Here are two specific examples:

- Dragging a tree icon from the parts box to the view window: if
any part of the extent is in the title bar or the toolkit when you
release the mouse button, the tree is not copied to the view
window.

- Dragging a MENU tree ENTRY from the parts box to the menu box
in the view window: if any part of the ENTRY extent is outside the
meanu box (its parent) when you release the mouse button, the
ENTRY is not copied to the menu box.

@ If you are moving or copying a tree or objaect to the clipboard, drag
from'the upper left corner of the tree or object. If you don't, and if
any part of the extent is off the left edge of the toolkit, the tree or
object-is not moved or copied to the clipboard. (The clipboard is
described.in Section 3.) ) '

Note also that when you copy a tree or object, the copy does not
retain the tree or object names associated with the original.

Sizing Ohiects

To change the size of an object, first "select the object. GEM RCS
highlights the selected cbject with a dotted outline and displays the
object's "size handie” (a solid black rectangle) in the bottom right
corner. Then place the pointer on the size handie and drag the size
handla until the object is the size you want.

It the object has children, note that GEM RCS won’t permit you io
make a parent object too small to contain its children.

Deleting Trees or Obiecis )
To delete a tree or object, do any of the following:

® Drag it from the view window to the trash can icon in the tooikit.
Whan the trash can icon is highlighted, ralease the mouse button.

® Click on the tree or object to select it. Then move the pointer to

1-8
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the trash can icon (wulhom dfaggmg the tree.-or 0b|e( () and [Cllck on
the trash can. .~ co L

® Select the tree or object and then choose 1he Delete mmmand from
the Edit Menu. . T T TR PIS

ot

You cannot retneve an item once vou place lt in the trash can"‘

A

WORKSPACE AND MEMORY USE

When—you start GEM RCS it requests a pomon of vour compulers
memory as its workspace. Depending on how much RAM is available,
this workspace can be as much as 64K.

)..J,.

As you. add trees and ob|ects vou whltt\e awav at lhe ai.rallable
workspace. However it 'you. delete a tree or ob]ect GEM RCS does
not rastore the portlon .ot the workspat.a occupied by the tree or
object. The only  way you can regain that ‘memory is by savmg the
file. The Save and Save As.. commands (described fully in Section 3}
write out and relcad the resource.

To find out how much of the workspace is available, choose the Info...
command from the Options Menu. (Menu commands are described
fully in Section 3) The information dialog tells how many bytes the
file, tree, or object has used and how much space remains in the
warkspace.

Note: The file size shown in the information dialog is only an
approximation of the size of the resource file GEM RCS will produce,
for the following ressons:

® Alerts actually take less space in the final file because they are
written out as ASCIl strings.

® Shift-dragged copies of objects might use more space in the final
file.

End of Section 1

1-9




~ Section 2

GEM RCS Tutorial

In this tutorial introduction to GEM RCS, you will start GEM RCS and
then create the menu and dialog box shown below.

Foaii[... AL . . |
Deletl‘lfile... AD Political party? Republican [ndependent]
| Rotate Symbols

S L] el

You will then save the resource file and exit GEM RCS.

STARTING GEM RCS

To start GEM RCS, start the GEM Desktop and then do the following:

1. Open the TOOLS folder and locate the RCS.APP icon.
2. Double-click on the RCS.APP icon.

CREATING A MENU.
The. menu you will create in the following steps contains simpla text

string commands. This part of the tutorial demonstrates opening 8
tree, adding objects to the tree, setting attributes, and sorting objects.




Creating a Menu . , GEM Resource Construction Set

Choosing a_nd Naming a MENU Object ‘I:ree icon

The parts box contains icons for the five kinds of object trees you can
construct with GEM RCS:

| MENL R YTYTYR I F -] —m
o N e I L -5 .m:!

--------- EE=)] PpANEL ALERT FREE

Drag the MENU icon into the view window. You don’t have to locate
the icon precisely; when you release the mouse button, GEM RCS
. automatically places a copy of the icon in the upper ieft corner of the
window. (Remember that'GEM RCS does not copy the icon to the
view window if any part of the outline you're dragging is in the toolkit
or the title bar.)

Whenever you place a new object tree in the view window. GEM RCS
displays a dialog that asks you to name it.

Enter Tree Nane
Note: fi non-blank name is required.
Nawe: TREEL| _

Note that the dialog already contains the name TREEYl. To use this
neme for your object tree, you would simply click on the dialog's OK
button or press the Enter key. In this case, however, give the object
tree a different name. Pross the Esc key to erase TREE1, type the
name APPMENUS, and then click on the OK button or press the Enter
key. (See your GEM Desktop guide for a full description of entering
and editing text in dialogs.)

2-2




GEM Resource Construction Set Creating a Menu

Opening the Object Tree

Double-click on the APPMENUS icon. The following changes take
place.

® The title bar now says APPMENUS.

® The view window contains a menu bar with two titles--File and
Desk--and a shaded background area. {(The Desk Menu is at the
extreme right of the menu bat.)

® The parts box contains the four objacts that can appear in the MENU
object tree: the menu TITLE, an ENTRY (each command text string is
an ENTRY), a line pattern to separate entries, and a box in which
you can place menu items that are not text strings (fill patterns or
line styles, for example).

In this tutorial you'll create a new menu from scratch. in Section 3
we'll tell you how you can use the existing File Menu and Desk Menu.

Adding a Menu Title

Drag the TITLE object from the parts box to the manu bar, placing it
after “File”. Be careful not to drag into the GEM RCS title bar or the
toolkit. If you do, GEM RCS cancels what you've dragged.

Now double-click on TITLE. The following dialog appears on your
screen:

Edit Unformatted String Object

A A

Text: STRING :
| 20 30 40 characters

(Optional) Object Mame: ___ - m

Do the following to edit and name the menu's title:

1. Press the Esc key to erase the text.

2-3




Creating 8 Mghu GEM Resource Construction Set

2. Press the spacebar, type Options, and then press the spacebar
again. {if you don't press the spacebar. there won't be enough blank
space betwean menu tities.)

3. Move the cursor to the Object Name fieid and type OPTITLE.

4. Click on the OK button or press the Enter key.

Adding Entries to the Menu
To add entries {commands) to the menu, do the folowing:

1. Click on the menu’s title, Options. This selects the title and also
displays a small menu box below the menu bar.

2. Place the tip of the pointer just inside the lower right corner of the
menu box and press the mouse button. When the pointing finger
icon appears, drag down and to the right to make the menu box
larger. Make it larger than you think you need; you'll make it the
right size later. :

3. Drag an ENTRY from the parts box and place it in the upper left
corner of the menu box. Don‘t crowd the corner too tightly, and
make sure the outline you're dragging is entirely inside the menu
box.

4. Copy this ENTRY by Shift-dragging. Place the copy just below the
first ENTRY.

5. Drag a separator line from the parts box and place it just below the
two entrias.

6. Shift-drag the ENTRY once more, placing the new COpy below the
separator line.

Editing the Entries

The next step is to convert each generic ENTRY into a command an
end-user can choose. To do so, do the following:

1. Double-click on the first ENTRY in the menu. GEM RCS displays the
Edit Unformattaed String Object dialog.

-

Rtigmis. SN

-
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2. Press the Esc key to erase the text in the dlalog

3. Press the spacebar twice (to.put. two blank spaces before 1he

command) and then type Load File - (The tt\ree dots are. a GE!

~convention mdlcatmg that choo g he c mmand wiil cause 2 "
i‘? F o o

diatog 1o be displayed) Don't click on the OK button yet.

4. Many . GEM applications .use. keystroke equivatents for thelr menu
commands. Let's say the end-user could type Ctri-L to produce the
same effect as choosing the Load File... command. To indicate this
in the menu, press the spacebar several times and then tvpe ~L
foliowed by a single blank space.

5 Move the cursor to the Object Name field and tvpe OPSLOAD.

" 6. Clack on the OK button or press the Enter key

-~

Note to: Step 4::GEM application menUs foliow the convention that

f represents the Ctrl key.and that a fitled diamond represents the Alt
' key. (The keystroke combination: Ctrl-G produces a- filled -diamond in

the Edit Unformatted String Object dialog.) GEM application menus
also follow the convention of surrounding the command text string
with two leading blank spaces and a single trailing blank space.

Take the same steps for the second ENTRY, with the following
variations: ‘

® The command is Delete File....
® The keystroke equivalent is ~D.
® The Object Name is OPSDELT.

Don‘t forget the leading and trailing spaces, and don't worry if the ~L
and ~D don't line up properly at first. You can fix that simply by
adding or removing spaces in the Edlt Unformatted String Object
dialog. The edlting techniques are the same as for any GEM
application dialog.

Now edit the third ENTRY, with the following variations:

e The command is Rotate Symbols.
@ [t has no keystroke equivaient.
® The Object Name is OPSROTE.

2-5
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Sizing the Menu Box

" To make the menu box the right size, first select the box by clicking
inside it away from the commands or the separator line. You'll know

you have been successful if the size handle appears at the boxs lower.. .

right corner.
Next, drag the size handle until the menu box is the size vou want.

You can also size the menu box wnhout first selectmg it. Use the
same technique described in Step 2 under “Adding Entries to the
Menu.”

Sizing the Commands

Because GEM: AES only highlights and enables the area contained
within ' the extent’ of an ENTRY, you should make each command’s
extent match the full width of the menu box. If you don’t, your
application's menus will have a visual and functional inconsistency that
the end-user will probably find displeasing.

To size a command, you can do any of the following:

® Selact it and drag its size handle all the way to the right border of
the menu box.

) ® Selact it, display the alignment pop~up menu (see
‘-D-) left), and choose the Fill Horizontal option.
¢

® In the Text field of the Edit Unformatted String Object dialog, put
blank spaces after the string value of each ENTRY.

Extending the Separator Line

To extend the separator line all the way across the menu box, do the
following:

1. Double-click on the separator line. GEM RCS displays the Edit
Unformatted String Object dialog. The heavy bars in the Text field
of the dialog are equivalents to the shaded separator line in the
menu. ‘




GEM Reseurce Construction Set ‘ Creating_'gt‘h Menu -

2. To extend the line, tvpe several Clrl S combmatrons in the Text_ 4

field. N o o ‘
3. Click on the OK button or press the Enter key. .

If the line is not long-enough, repeat these steps untii it is. 1f the line
is now too long, GEM RCS dispiays an alert that this object no longer
fits inside its parem Click on the dialog’s OK button and then double-
click on the separator line again. Use the Backspace key to erase the
bars until the separator line is the right length.

Sorting the Objects in the Menu g

The last thing you should do before closing a tree is sort the objects
in it. If you don‘t, at run-time your application wiil draw the objects at
each Ievel of the tree in the order in which you created them, which
may be vrsuallv displeasing. By sorting the ob]ects you can determine

‘the order in which they will be drawn.

To sort the objects in your menu tree, do the following:
1. Ctri-click on any of the commands. This selects the menu box.

2. Display the Hierarchy Menu and choose the Sort Children..
command. GEM RCS displays a dialog with four sorting options:
~ single-row, single-column, double-column, double-row.

3. Choose the single~column option (second from the left) and press
the Enter key or click on the OK button.

Closing the MENU Object Tree

Your menu is now complete. To close its object tree and return to
the root level of the resource file, click on the ciose box or choose the
Close command from the Fite Menu.

CREATING A DIALOG 80X
The dialog you will creats in the following steps contains a text string,

a set of “radio buttons,” and two exit buttons. In addition to
demonstrating more about setting attributes and sorting objects, this
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part of the tutorial illustrates working ‘v'vit_h"‘ a three-level ‘tree, where
one of the children of the root object has children of its own. ‘
. i

Choosing and Naming a DIALOG Object Tree lcon

The first step, in :‘c;oatin a dialog box is the same one you took in
creating the menu: choosing and naming the object tree icon. ‘

Drag the DIALOG object icon from the parts box and place it in the
view window. When GEM RCS displays the naming dialog, press the
Esc key to erase the default name (note that it is TREEZ; the MENU
was TREE1), type PTYDIAL, and click on the OK button of prass the
Enter key. ‘

Opening the Object -t;dc

To ope_n‘ qut dl,alo'g‘ :b'ox‘s object tree, double-click on the PTYDIAL
icon. Note the following changes to your screen:

® The name of your object tree, PTYDIAL, appears in the title bar at
the top of the view window.

® The view windm}v is now empty.

® The icons in the parts box change, showing you the objects you can
include in your dialog box. '

Choosing Ohjects for Your Dialog Box _
To assemble the objects for your dialog box, do the following:

1. Drag the STRING object from the parts box, placing it in the upper
left of the view window.

2. Drag the hollow box object (see laft) from the pans
l: box and pilace in the upper center of the view

window.

3. Click on the box to select it. Note the object's size handle
(mentioned under “Sizing Objects” in Section 1) at the lower right
cornar of the extent.
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4 Drag the box's size handle down a little and almost to the right
border of the v:ew wmdow making a long, shatiow rectangla

5. Drag the BU'!TON object from the parts box and place it i_rlggge the
box you just enlarged, in the upper left corner.

Customizing the STRING Object

Double-click on the STRING object in the view window. When GEM
RCS displays the Edit Unformatted String Object dialog, press the Esc
key to erase the text and then type the following:

Political party?

You don't need to do anything with the optional object name, so click
on the OK button or press the Enter key to complete your work in the

<. Edit Unformatted String Object dislog. The STRING object in your
"dialog box now contains the phrase you just typed. (Don't be

concerned if the massage overlaps the box or BUTTON object. We'll
reposition evarything later.)

Customizing the BUTTON Object

To change the text inside the BUTTON object and to give it a name to
which you can refer in your program code, do the following:

1. Double-click on the button. GEM RCS displays the Edit Unformatted
String Object dialog.

2. Press the Esc kay to clear the existing text.
3. Type Democratic.

4. Click on the "Object Name” field. The text cursor moves to this lina.
‘(You can also move the cursor by pressing the Tab key or the
down-arrow key.)

5. Type DEMBTN. (Tc make reading your code as easy as possible.
you shouid use object names that indicate the objsct’s function.)

6. Click on the OK button or press the Enter key

Creating a Digiég‘f Box
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L E R

Setting a\Rad\io‘Buttgn _ : L :
The “Democratic® button and two others {you'll craate them in’ just a
moment} will make up a set of “radio buttons.”: Like the 'pushbuttons
on a car radio, radio buttons have the following characteristics:

® In a set, only one button at a time can be selected, but th_ere shpt_l!d
always be a selected button. There should never be a case where
no button is selected. -

® Selecting a button automatically de-selects the previousiy"gpleciqq
button in the set. S T

To set the button as a radio button, do the following:

1. Click on the “Democratic” button to seiect it.

— | 2. fcuck; ‘on the attributes menu icon (see left) and
- click on "Radio Button” in the pop-up menu that
appears. Coe

Creating Additional Radio Buttons

This dialog has two additional radio buttons, “Republican” and
"Independent”. To create these buttons, do the following:

1. Shift-drag the "Democratic” button twice, placing the two copies to
the right of the original.

2. Double-click on the copy immediately to the right of the original. In
the Edit Unformatted- String Object dialog, change the text to
*Republican” and the object name to *REPBTN".

3. Double-click on the last topy. In the Edit Unformatted String Object
diaiog. change the text to “Independent” and the object name to
“INDBTN". - -
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Designating the Selected Radio Button TR

When the dialog appears at run-—tnme one of 'the radio buttons must-
be pre-selected (hithlghtad in: reverse wdeo) To pre-sslect the

“Demaocratic” button, do the: fOIlowmg et

1. Click on the button to salg;:; it
2. Click on the attnbutes menu icon and choose "Selacted'

Customizing the Parent Box

Bafgre you work on the pai';ﬁ;i hox, you might want to know why you
need one in the first place.

-~ When:you have more than one "set of radio buttons in a dialog, you

must- enclose each- sa! .inside_a parent box. If you don't, clicking on

....one. button will turn off all ather radio buttons in the dialog, not just
"the buttons in that one set.

In this dialog, with only a single set of radio buttons, you don‘t really
need a parent box, but the dialog could have additional sets labeled
“Age group?” and "Salary range?” This step will demonstrate what to
do when you do need the parent box.

First, arrange the radio buttons in the parent box. (The "Democratic”
butten should be in the box's upper left corner) Than select the
parent box (if it isn't already selected) and size it down as small as
you can make it.

You don't want the parent box to be visible in the final dialog. To
make it invisible, do the following:

1. Select the box, if it isnt already selected.

2. Click on the border width menu icon (see bhalow).

3. In the border width pop-up menu, choose the null border. See the
illustration on the next page.
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It you de-select the parent box by clicking elsewhere in the view
window, you'll sea that the parent is now invisible. However, you can
still selact it by Ctri-clicking on one of the radio buttons, and you can
move it {(and the buttons too) by Ctri-dragging any of the buttons.

Creating Exit Buttons

The dialog needs two “exit buttons”™ with which the end-user can exit
the dialog by clicking on either button.

To create the exit buttons, do the foliowing:

1. Drag a BUTTON object from the parts box, placing it below the radio
buttons.

2. Shift-drag this BUTTON object, piacing the copy just to the right of
the original. .

3. Edit and set attributes for the first BUTTON as follows:

® Change its text to “OK”
® Name it OKBTN.
® Set its attributes to "Exit” and "Default”.

Making a button the ~default” means that at run-time the end-user
can select this button either by pressing the Enter key or by clicking
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on it. (You've alreadv encounlered a default button m the Ed:t
Unformatted String Object dlalog the OK buttoni 5 . :

3

4. Now edit and set attributes for the second exit but.ton as fol"ldws;

® Change its text to “Cancel”
® Name it CANCLBTN.
@ Sat its attribute to "Exit".

5. Finally, locate the exit buttons where you want them.

' Resizing the Background of Your Di_alog Box

Move the pointer to an open area of the view window (away from the
text and byttons) and click. The dialog box’s size handle appears in
the bonom right corner of the view window.

B 'Place the pomter on the size handte and drag up and to the left. As
'vou drag, the backgroumd of your diatog box gets smaller. When the

background is the size you want, release the mouse button.

Sorting Objects in the Dialog

The iast thing to do before closing this tree is to ‘'sort the objects in it
The procedure is essentially the same as with the SAMPLE dialog.

Note: You must sort all levels (sets) ef children. For example, this
dialog has two levels. The radio buttons are children of the empty
box, and the empty box, string, and exit buttons are children of the
dialog’'s outer box.

To sort the children in your dialog, do the following:
1. Ctrl-click on one of the radio buttons. This selects its parent box.

2. Display the Hierarchy Menu and choose the Sort Children..
command. Click on the single-row option {(on the far left) and press
the Enter key or click on the OK button.

3. Select the dialog’s outer box.

4. Display the Hierarchy Menu and again choose the Sort Children..
command. This time click on the double-row option (on the far
right) and press the Enter key or click on the OK button.
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PRI T ‘ LR i s s T
Sorting the objects will draw them, in the following order; ... ...
. “Political party?” string 5 . '
2 Radio buttons, “Democratic® first.
3. OK button. ,_,-‘;,_-f‘:g:;. BRI R
4. Cancel button. I k) ;u 0oh i
A Ty 8

Closing the DIALOG Object Tree « e g by R

Your dialog is now complete. To close its object tree and return to
the root level of the resource-file, click on the ciose box.or choose the
Close cornmand from the File Menu.

R TTEA TR U AN SR TV PR S UL ST IR T

Cordy o v o e Lo P s
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SAVING A RESOURCE FILE ' v B iernesio Do iy

Ly R ‘4:“"""” g @by s e sy Dy s g Gt
Dlsplay the Fnle Menu and choose the Save As.. command The. item
Selaector- appears On your scraen. L : e

Type TEST and then click on the OK button or press the Enter key
GEM RCS saves the following files:

TEST.RSC The actual resource file you would include with your
application program. Note that you do not need to
type the .RSC file extension; GEM RCS automatically
supplies it

TEST.OFN An auxiliary file that identifies the trees and objects in |
your resource file. When you work in GEM RCS, you
need both the resource file and its .DFN file in the
same dlrectory

If you have craated resource filas with GEM RCS, the
earlier version of the Resource Construction Set, the
definition file has the extension .DEF. To use this file
with GEM RCS, simply change its extension to .DFN.

tn its initial default configuration, GEM RCS also creates TESTH, a C
language include file you must use when you compile your application
program code. The .H file is an ASCH file that lists the trees and
objects in your resource file and the object numbers assigned to them
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by GEM RCS. You can also read this file 10 check the o‘r"der" in which -

objects have been sorted. Sorting is discussed in this tutorial and also
in the description of the Hierarchy Menu in Section 3. :

Note: You can also produce -inctude files for Pascal, BASIC, and
FORTRAN-77, as well as an editable ASCIl version of your resource file
{the .RSH file). See the description of the Output.. and Save
Preferences commands in the Global Menu (Section 3) and the
description nf RSCREATE in Section 4.

QUITTING GEM RCS

To stop GEM RCS, choose the Quit command from the File Menu. You
then return to the GEM Desktop.

End of Section 2




.Section 3

GEM RCS Reference.

ASPECT RATIO AND SCREEN RESOLUTION
GEM applications can run under a variety of aspect ratios and screen

resolutions. The following table lists the three most common
combinations.

Table 3-1. Screen Resolution and Aspect Ratio

Resolution Pixel Ratio Aspect Ratio
tow . 640x200Q 3.21
high’ 640x400 1.6:1
high® 720x350 2.06:1
square’ - any 11

&
Although their aspact ratios are different, the GEM software uses the sams scresn
driver for these resolutions.

it an icon or bit image is displayed on a system with an aspect ratio
ditferent from the system on which it was created, the icon or bit
image will appear taller or shorter than it appeared in the original.
This can cause problems if you are placing icons or bit images close
together; aspect ratio differences can cause them to overlap each
other or separate from each other.

You can rasolve this issue in either of the following ways:
® You can create a single resource file and compensate for the

differant aspect ratios of the systems on which you expect your
application to run,
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® You can create different sats of icons and bit images for each’
expected aspect ratio. . You can then create aspect ratio-specific.
resource files from a smgle master ﬂle by loading the appropnate
set of icons and bit images intd each fina! version of ‘the: resource\

file. | B GE

The tollowing illustrations demonstrate these two approaches. On thé"'-
teft, you see a partial view of the GEM RCS toolkit, which was created
onty in a low-resolution version. Note how the bit images are
flattened on a high-resolution system. On the right. you see partial
views of the GEM Paint™ toolkit, which exists in both high- and low-
resolution_versions.

C
1 3
(-D-i 8
‘b .
-!:I F_ L]
GEM RCS GEM RCS GEM Psint GEM Paint
lo-res !\i-res lo-res hi-res

if you create aspect ratio-specific resource files, at run-time your
application can determine the screen’s aspect ratio and resolution and
ioad the appropriate file.

For more on icons and bit images, see “lcons and Bit Images.” later in
this section.

Note: Aspect ratio differences do not cause problems with text or any
other objects in a tree.
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FILE AND DESK MENUS

As noted in the tutorial, when you open a MENU object tree, there are
already a File Menu and a Desk Menu [i‘r'la the menu bar. A

Sy

File Menu , S .. _
The File Menu is optional; you can drag its title to the trash can.
To add commands to the File Menu, do the following:

1. CHck on the menu title. - This selects the title and -dlsplavs the menu
box with a single command, Quit.

2. Place the pointar ‘at-the lower right corner of the menu box, and
Ctri-drag: down and 1o the right. This makes the menu box larger,
without:affecting the size or location of the command. Y

CehA

3. Drag the Quit "cbrhﬁian'd to the bottom of the menu box, or place it
wherever you want it. = S o ’

From this point, you can create the menu just as you did in the
tutoriat. _

Desk Menu

This menu is required; you cannot drag its title to the trash. However,
at run—time its name and location can vary as follows:

e if your epplication is running under version 1.X of GEM AES, the
menu is called the Desk Menu and appears at the left side of the
menu bar. ’

® It your application is running under vaersion 2.X of GEM AES, the
menu appears at the right side of the menu bar, and the menu’s
name is the filename of the application’s executable file. For
example, for an application executed by a tita calted BINGO.APP, it
would be the BINGO Menu.

The name variation and menu piacement are handted entirely by the
GEM AES.

The Desk Menu contains several “placeholder” commands. The first--
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Your message here--is fully editabie {(the message has a 20-character

maximum), but you cannot delete -it. Ar:typical function. for this.

command is to display an mformational dialog about the appllcanon
including its version number.

R

The numbers below the separator line are placeholders forf’dé_sk:,

accessories. The menu can accomodata a maximum of six....You
cannot edit or delate these entries. GEM AES handles placing desk
accessory names in the menu and sizing the menu according 10 the
number of ._3sk accessories it contains.

USING THE PARTS BOX

The pans box contains icons for the objects vou can include m an
object tree Thesa objects have preassigned attributes (fill patterns,

-”_‘-colors. text  strings, etc.) you can change with the tools in the toolkit.
You can .edit text in an object or make other changes by double-

clicking on the object to display one of a variety of dialogs.

To place an object in your current object tree, drag its icon from the
parts box to the view window.

The contents of the parts box depend on thse ftvpa of tree you are
creating, as the following sections explain.

MENU Tree Objects

TITLE Menu title for the menu Dpar.
ENTRY Command string for the menu.
LI Separator line for the menu. Use the separator line

to separate commands into logical groups for the
end-user’'s convaniance.

:] Hollow box you can place in a drop-down menu.
You can use the holiow box to define the selectable
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I S o IR ) : : b
R P (reversible) axtent ot a bu nmage in. tha menu For' T
Cob i an example. :see the: Gallerv Menu  in the. GEM-

Graph™ application. = ..oy et

1 . s S cer : : :
e SR AT R R R TE S PY A P E S N F R OF UG A E STRE R A

\DIALOG Trce and PANEL Trco Obiects Si aneig g
_The same ‘set of obiects is avallable for DIALOG and PANEL trees. in
the following descriptions, the 'names in parentheses are ob]ect types
described in Section 6, "Object Library,” in the GEM AES Reference
Guide.

mmm R (¢ _BUTTON) - Boxed string the end user selects 10

. mdieate a chotce among. altemanves Cvh

I

SIRING

YRR N .1\1‘ %H“f! BT TR B SRR

(G. STRING} Boxleés character strlng ' notmanv
_f__;ls,‘“‘ contalmng explanatorv text Ior the end user. f‘
EDIT: o {G_FTEXT) ?'-{%A formﬁtt_ed text field the end-user can

change.

.
T [P [

m: (G_FBOXTEXT) - A formatted text field inside ‘a{ box.
The end-user can change the text field.

A
[N

:’ (G_IBOX} - Hollow box through which the end-user DR
‘ can see the fill pattern or text beneath. - RERERN
:] (G_BOX) - Opaque (noﬂi'franébarent) box.

TEXT (G_TEXT) - Formatted text. You can salect sizes,

colors, fonts, and masks for these objects.
E] {G_BOXCHAR) - Single character in an opaque box.

mm (G_BOXTEXT) - Same as TEXT, but with a
surrounding, opaque box.
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i .. . {GICON) - Use to d:splay an_icon (data plus mask)
., created, wnh EM IconEdlt o S
1C0OM . R 2
AN Loy v RS .
(G_IMAGE) - Use to display a bit image (data field
lD only) created with GEM icongdit. R
IMACE '

LY . RSO R : il

ALERT Tree Objects

Alarts usp an optional warning icon, up to five message lines, and up
.to threa’ exit buttons. The descriptions of the icons {below) also
f’:’, suggest how each kind of alert might be used. This “philosophy” "

' entsreiv optional

‘ EUttOI‘I: The defauit state of an exit button in‘ an ALERT is
' set in your program code.

|'|GSS&99 ’Line An unformatted text string telling the end-user the
nature of the problem. An alert can have 3
maximum of five message lines, each with no more
than forty characters.

NOTE icon. This is the default icon. This kind of

l“ alert can inform the end-user that he has attempted
somathlng the application does not pormit . The
alert might only have an OK exit button, so the user
can acknowledge the massage.

user that he has requested a permitted action, but
that the action is not possible under the present

» circumstances, perhaps because a drive door is
open or there is no disk in the drive. The message
text can suggest solutions. The alert would have
two exit buttons, Cancel and Retry.

? WAIT icon. This kind ot alert can inform the end-
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user that his"’ request while’ ‘perfectly legal, can
result in the loss of data. Formatting a disk is one
example. The alert would have two exit buttons, (8] 4
..., and Cancel, . -

iad
=N

e
:
i

T

FREE Tree Objects

cy

Free-string Al'\ unforrpatted text string containing the text you
wish to display.

A bit image (data fieid ontv) crohted with GEM
lconEdit

Voanydo

OBJECT CLASSES

The objects in the parts box can be divided into five classes:

® unformatted strings
® box type

& formatted text

@ hit images

® icons

The following table lists the object classes, the object types in each
class, and the object trees in which they can appear.

STOP icon. This kind of ‘aiert'can warn the | lendt
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Table 3-2. Object Classes

b PRy ettt

Object Class Object Type - - Object Tree(s)"
Unformatted String  TITLE e MO
ENTRY . ' M
separator line M
BUTTON D.PA
STRING DP
Message Line A
Free-string F
Box Type all boxes, including outer M,B.P
' : box of DIALOG or PANEL
single character in box D.P
_ Formatted Text TEXT D.P
BOXTEXT D.P
editable text (EDIT: ) D.pP
boxed editable text D.pP
Bit Images IMAGE D.PF
icon ICON D.F

.M = MENU, D = DIALOG, P = PANEL, A = ALERT, F = FREE

Unformatted Strings and Formatted Vext

GEM RCS provides two ways of entering text in object trees:
unformatted strings and formatted text. The following table lists some
of the characteristics of and differences between these two kinds of
text. ’
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Table 3-3. Unformatted Strings and Formatted Text

Unformatted Strings Attributes can be set.
Can be aligned within parent.
System font and color only.

Transparent mode only (background
color and pattern show through).

Always left-aligned in extent.

Formatti;d Text,” " Attributes can be set.
l Can be aligned within parent.
Colored text available.
Small font available.

Transparent mode or replace mode
(background color and pattern do not
show through).

Text can be left-aligned, right-aligned,
or centered within extent.

Outline color availabie (boxed formatted
text only).

Outline  thickness available (boxed
formatted text only).

ADDING OBJECTS TO TREES

To add an object to your tree, drag its icon from the parts box to the
view window. You can then Shift-drag the object in the view window
to make sdditional copies.
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The Shift-drag technique is especially useful if you want two Or more
objects with the same attributes. For example, if you want three
buttons with attributes in common, drag one BUTTON object from the
parts box, set the common attributes, and then copy it twice, rather
than dragging the object from the parts box three times and setting
the attributes three timaes. , ‘ ,

Special Cases

MENU trees The TITLE object can be placed only in the title -
bar. The ENTRY, separator line, and hollow box
objects can only be placed in the menu box.

You cannot add or remove objects from the
Desk Menu. The first line of the Desk Menu is
the only aeditable entry.

ALERT trees An ALERT tree can only contain one warning
icon. To replace the default NOTE icon, drag
another icon from the parts box and place it
inside the alert. GEM RCS automatically deletes
the NOTE icon and positions the new icon. If
you don‘t want an icon, drag the existing one 10
the trash can.

An ALERT can have a maximum of three exit
buttons and five message lines of nho more than
forty characters each. GEM RCS automatically
adjusts the size of the alert box to the langth of
the message text.

MOVING, COPYING, AND DELETING OBJECTS

Moving and copying objects are described in Table 1-1. Also see
“Using the Clipboard,” later in this section.

To delete an object, do one of the following:

® Drag it to the trash can.

® Select the object and click on the trash can icon.

® Select the object and choose the Delete command from the Edit
Menu.
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SIZING OBJECTS

You can size most objects by selaecting the object and then dragging
its size handle.

Some objects--including STRING objects and others whose contents
you edit in the Edit Unformatted String Object dialog--change size
automatically when you add to the text in the object. However, such a
change might violate the parent-child size relationship, whlch is
described next.

MAINTAINING THE PARENT-CHILD SIZE RELATIONSHIP

As detailed in Section 6 of the GEM AES Reference Guide, object
structure rules require that the parent object always contain its
children. This means that the child cannot be larger than its parent
and that the child cannot extend past the boundaries of the parent.

In several cases, GEM RCS protects against violations of the parent-
child size reiationship. For example, you cannot size down a menu
box so that the entries or separator lines extend past the edge of the
box. Similarly, you cannot enlarge a BUTTON object to extend past the
adge of a dialog box.

However, by editing text strings in the Edit Unformatted Strlng Object
dialog, you can make the following objects too long to fit inside thair
parent objects: ‘

® a STRING in a dislog or panel
@ an ENTRY object in a menu box

For example, you can type text into an ENTRY so that the command
extends past the edge of the menu box. In this case, GEM RCS
displays an alert warning you that the child does not fit inside its
parent. You have two options: -
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oK GEM RCS accepts the long ENTRY and automatically
enlarges the text string’s extent to include the entire
string. You should then make the menu box larger. (if
you don't, be forewarned that GEM AES only writes to
the menu/alert buffer and redraws the part of the screen
under the menu box. Anything outside the menu box
will ramain on the screen as garbage))

Cancel GEM RCS ignores your changes and retains the original
ENTRY text.

ICONS AND BIT IMAGES

icons and bit images are both created with GEM IconEdit.

An icon consists of DATA (the “picture”) and MASK, usually a solid
“shadow” of the DATA. The function of the MASK is to prevent any
background colors or patterns from showing through the DATA. You
can edit an icon to include a text string or a single charactar at any ot
several positions relative to the icon. See the description of the Edit
lcon Object Dialog, later in this section.

A bit image is DATA only. Because it has no MASK, the bit image
allows any background color or pattern to show through. Unlike icons,
bit images cannot be edited to include text strings or characters.

Loading icons

To ioad an icon into a DIALOG or PANEL tree, drag the ICON icon from
the parts box to the view window. Then select the icon and choose
the Load.. command from the Options Menu.

GEM RCS first displays a dialog asking if you want to load the icon’s
DATA, MASK, or both. If you {oad DATA only, any background color or
pattern will show through the icon. If you load MASK only, you will
simply block out any background color or pattern, but the icon’s image
will not appear.

f you choose both DATA and MASK, GEM RCS displays the Item
Selactor twice. The first time, selact the icon’s DATA. When GEM RCS
immediately redisplays the ltem Selector, select the icon’'s MASK.
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Note: The fites for DATA and MASK both have the extension .ICN.
You'l! need some naming convention to distinguish the two. like
ICOND.ICN and ICONM.ICN.

Loading Bit Images

To load a bit image into a DIALOG or PANEL tree, drag the IMAGE icon
from the parts box to _he view window. Then select the icon and
choose the Load.. command from the Options Menu. GEM RCS
displays the Item Setector, and you can select the bit image file

Like_icons, bit image files have the ICN extension.

USING FREE TREES

As noted in Section 1, FREE trees can be used to enable context-
sensitivity in your application at run-time. We'll use GEM RCS as an
example of how you can use Free-string objects and FREE images.

Note: You can assemble your Free-strings and FREE images in as
many FREE trees as you like, mixing and matching as the spirit moves
you. However, when GEM RCS saves the rasource file, it combines all
Free-strings into one tree {called FRSTR1} and ali FREE images into
another tree (calied FRIMG1).

@

Free-String Objects

The GEM RCS resource file contains several strings in the tree FRSTR1,
including the following commands:

@ Hide Parts
® Show Parts

The default form of this command (Hide Parts) is contained in the tree
for GEM RCS’'s menus. When the end-user chooses the command, the
application changes the pointer for the command string from the
default in the MENU tree to the alternate (toggled) command in the
FRSTR1 tree. The next time the GEM AES screen manager draws the
menu, it uses Show Parts from FRSTR1. From then on, as context
requires, the application swaps in and out the pointers to the two
forms of the command in FRSTR1.
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Note: If you change the length or spacing of the string in the tree
containing the defauit. don't forget to make the same changes to the
related free-string or strings.

FREE Image Objects

The GEM RCS clipboard {described later in this section) is a context-
sensitive object. Its default appearance is a bit image object in the
toolkit's o! 2Cct tree. The tree FRIMG1 contains its alternate
appearance (dogeared. to indicate that the end-user has placed
something on the ciipboard) and a duplicate of the defauit version.

When the end-user places something on the clipboard, GEM RCS
swaps in the dogeared bit image from FRIMG1. The next time the
default version is needed, GEM RCS uses the duplicate from FRIMG1,
and from then on GEM RCS swaps in and out the two versions from
FRIMG1.

USING THE OBJECT EDITING DIALOGS

When you open an object in the view window, GEM RCS displays one
of the following dialogs:

® Edit Unformatted String Object
@ Edit Box Type Object

® Edit Formatted Text Object

& Edit Bit Image Object

& Edit lcon Object

The dialog displayed depends on the class of object opened (see Table
3-2).

Each object editing dialog is difterent {see the individual descriptions
following), but in each case you can use the dialog to name or rename
the object you're working on. To do so, click on the line following
"Object Name” and type the name you want to assign to the object.
You can then refer to this name in your program code.

3-14
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Edit Unformatted String Object Dialog

The default text, BUTTON or STRING, appears in the “Text” field. To
edit the field, press the Esc key to erase the text in the field and then
type the new text. You can move the cursor back and forth in the
field with the left- and right-arrow keys, and you can erase characters
with the Backspace and Delete keys.

To help you gauge the length of your text strings, the dialog marks
the “Text” field at 20, 30, and 40 characters.

See “Unformatted Strings and Formatted Text,” earlier in this section,
for a discussion of the differences between unformatted and formatted
text.

Edit Box Type Object Diaiog

If the object is the single character in a box (object type G_BOXCHAR),
the “Character” field contains the default character. You can edit or
erase this character as you wish. For all other box objects, the
“Character” field is empty, and GEM RCS ignores any characters you
enter in it.

Edit Formatted Text Object Dialog

The Edit Formatted Text Object dialog exists in two forms: one for
editable text (G_FTEXT and G_FBOXTEXT objects) and another for non-
editable text (G_TEXT and G_BOXTEXT objects). The ob_spec value of
ali four object types is a POINTER to a TEDINFO structure {see Section
6 of the GEM AES Refarence Guide). .

See “Unformatted Strings and Formatted Text,” earliar in this section,
for a discussion of the differences between unformatted and formatted
text. '

The dialog for non-editable formatted text has only one field, PTEXT, in
which you enter text. ‘

The dialog for editable formatted text has three fields: PTMPLT
(template), PVALID (validation), and PTEXT (text entry). These fields are
explained at length in Section 6 of the GEM AES Reference Guide
under "TEDINFO Structure.” Note that in GEM RCS, PTMPLT, PVALID,
and PTEXT use a tilde {~) in place of an underline () to avoid
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confusion between the field itself and the ptacehoiders for editable
characters.

The foliowing example illustrates how PTMPLT. PVALID, and PTEXT
create an editable text fieid in which the end-user can type the date.

PTMPLT>Today's date: ~~/~~/~~
PVALID>~~~~~~~~~ e~~~ 99~99~99

PTEXT > ~~ v~~~ 01~01~86

PTMPLT: To edit the field, press the Esc key and then type the new
string as shown above. The tildes take the place of the characters the
end-user-can edit at run-time.

PVALID: The validation field controis the tocation and type of the
characters the end-user enters at run—-time. A "9” in PVALID indicates
that the end-user may only enter a digit (0-9) in that position. Tildes
in PVALID represent literal characters that must appear exactly as
entered in PTMPLT.

PTEXT: The digits under the nines in the validation field appear as the
default entry for the field. The end-user can type over them 10
change the date. :

Edit Bit image Object Dialog

This dialog contains only the "Object Name” field and a reminder to
use the Load.. command (Options Menu) to.load the new bit image
data. “Loading Bit Imagas.” earlier in this section, describes how you
lcad bit images.

Edit Icon Object Dialog
In addition to naming the object, you can use this diatog for the
following:

® To enter and locate a text string you want to appear as part of the
icon.

® To enter and locate a single character you want to appear as part of
the icon.

The dialog contains two locator boxes: one tor the Text field and
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another for the Character field. You can locate a text string at the top.
middle, or bottom of the icon. You can locate a character at any of
nine positions relative to the icon.

See “Loading Icons,” earlier in this section, for a description of how
you load an icon. : ’

USING THE CLIPBOARD

The clipboard is 8 storage place for trees or objects
from the view window. You can move or copy items
to the clipboard, but only one item can be on the
clipboard at a time. Moving or copying overwrites
anything currently on the clipboard.

When you place an item on the clipboard, GEM RCS
dog-ears the icon to let you know there is something
there.

To cut a tree or object to the clipboard. do one of the following:

@ Drag its icon to the clipboard.

@ Select the tree or object and then click on the clipboard icon.

® Select the tree or object and then choose the Cut command from
the Edit Menu.

Cutting removes the tree or object from the view window.

To copy a tree or object to the clipboard, Shift-drag its icon, or select
the tree or object and use the Copy command on the Edit Menu.
Copying leaves the original icon in the view window.

To paste a tree or object from the clipboard to the view window, do
eittrer of the following: '

@ Drag from the clipboard icon.

® Display the Edit Menu, press the mouse button when the Paste
command is highlighted, and drag from the menu. Use this
technique if you have removed the toolkit from the screen with the
Hide Tools command. '

Either technique empties the clipboard.
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To copy a tree or object back to the view window, Shift-drag the
clipboard icon. The ciipboard still contains the original tree or object.

Whenever you paste or copy a tree from the clipboard, GEM RCS
displays the “Enter Tree Name” dialog so you can give it a unique
name,

You can use the clipboard as a holding place for an object from the
parts box ot one tree type and then add the object to another tree.
For example, you can add bit images to a MENU tree by doing the
foltowing:

1. Open a DIALQOG tree

2. Put a bit image in the DIALOG tree’'s view window and then cut or
copy it 10 the clipboard. '

3. Close the DIALOG tree and open a MENU tree.

4. Paste or copy the bit image from the clipboard into a menu. You
might want to make the bit image the child of a hollow box. See
the description of the hollow box under “MENU Tree Objects,” earlier
in this section.

Note: Be careful when you mix and match- objects this way. Some
objects and trees are incomgpatible, and mixing them can cause
unpredictable results. See "Unknown Object Tree Types” in Section 4.

GEM RCS clears the clipboard when you choose the New command to
begin a new resource file and when you choose the Open.. command
to edit an existing resource file. Both commands are on the File Menu.

USING THE TOOLKIT

The toolkit contains toois with which you can make a variety of
changes to a selected object, inciude the following:

® changing the objact’'s cotor

® changing the object’s filt . 'tern

® atigning the object within .. narent

® setting certain attributes fo: ine object
® changing the object’s line thickness
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A tool is disabled if its etfect is not meaningful for the selected object.
For example, the fili pattern tool is disabled for STRING objects
because STRING objects cannot have a fill pattern.

When you move the pointer over the toolkit, GEM RCS highlights only
the tools enabled for the currently selected object. To use a tool, click
on the highlighted icon. GEM RCS displays & pop-up menu of the
tool’'s options.

To choose from a pop-up menu, drag through the menu and click
when the option or command you want is highlighted. if you click
outside the menu. it disappears, and the cbject is unaffected.

Descriptions of the Tools

‘ Selects a background color for an object. The menu
appears in color if your computer can disptay color.
Otherwisa, assign colors using the numbered color

codes. These correspond to the codes described under
“Object Colors” in Section 6 of the GEM AES Reference

Guide

& Selects a fill pattern for an object.

% Note: For a fifl pattern to be visible, it must aiso have a
visible color. The defaults are white color and

transparent fill pattern.

Selects a color for a TEXT, BOXTEXT, FTEXT, or
FBOXTEXT object. The menu appears in cofor if your
computer can display color.

Aligns text, changes text size, or _changes the
background. For TEXT, BOXTEXT, FTEXT, and FBOXTEXT
objects only. Most of the commands are self-
explanatory, explanations and an ilustration  of
Transparent and Replace follow.
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Transparent - Makes each character cell (the text's immediate
background) transparent; the color and fill pattern of the box
containing the text shows through.

Replace - Makes each character cell opaque; tha text appears on a
solid white background.

4 Aligns or resizes an object within the boundaries of its
(-D.) parent. The alignment options are self-explanatory:
m explanations of the fill and snap options follow.

Fill Horizontal - Automatically resizes the object so that it extends
from the extreme left to the extreme right boundaries of the parent
object.

Fill Vertical - Automatically resizes the object so that it extends from
the top to the bottom boundaries of the parent object.

Character Snap - Snaps the seiected object in a PANEL tree to the
nearest character boundary. This is useful for precise alignment of
objects in the PANEL, which otherwise allows free piacement of
objects.

Selects attributes for an object. GEM RCS places a

marker next to any attribute assigned to the current

object. The attributes 'in the upper half ot the menu set
object flags (ob_flag) and affect the object’s interaction
with the FORM_DO call. The attributes in the lower half
of the menu set object states (ob_state} and affect how
the Object Library draws the object. See Section 6.
“Object Library,” and Section 7, "Form Library,” in the
GEM AES Reference Guide.
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Explanations of the attributes foliow.

Selectable - The end-user can select the object by clicking on it
Clicking displays the object in reverse video.

Exit - Clicking on the object fulfills an exit condition and causes
FORM_DO to finish processing and return 8 value. Typically assigned
to the exit buttons in a dialog. Objects with the Exit attribute must
also have the Selectable attribute. They can also have the Default
attribute, but that is optional.

Defauit - The object is selected automatically when the end-user
presses the Eriter key at run-time. |f you designate more than one
object in a tree as the default, you won't receive an error, but your
results are not predictable.

Note: The Exit and Default attributes each add a pixel to all sides of
the border of a BUTTON object. Thus, a button with only the Enxit
attribute has a two-pixel border, and a button with both attributes has
a three-pixel border.

Radio Button - Makes the object a member of a set of “radio
buttons.” Radio buttons are like the buttons on a car radio; pressing
one button makes another one pop out which means the end-user
can only select one radio button at a time. Members of a set of radio
buttons must be nested at the same level within a common parent
object.

Touchexit - Pressing the mouse button while the pointar is on the
object fulfils an exit condition and causes FORM_DO to finish
processing and return & value. The application does not wait for the
mouse button to come up. Objects with the Touchexit attribute must
not have the Selectable sttribute. ‘

Editable - The end-user can change information in the object at run-
time. Use only with editable text objects.

Hidden - Hides the object so that it is not disptayed on the screen.
Use the Unhide Children command on the Hierarchy Menu to display
hidden objects.

Shadowed - Draws a drop shadow around the object (usually & box}.
Shadows and outlines (see below) conflict.

Checked - Draws a triangle inside the left margin of the objecl.
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Outline - Draws an outline around a boxed object. Qutlines conflict
with shadows and have no effect on.boxes with outward borders.

Crossed - Draws an X through the dbiect in the system background
color. Use only with boxed objects

Disabled - Draws the object at half-intensity (gray). The end-user
cannot select a disabled object.

Selected - The object is preselected (appears in reverse video) when
the end-user sees the tree.

The menu appears in color if your computer can display

— Selects a color for the border around a boxed object.
!___ color.

BUTTON. The defauit thickness is a singie pixel around
the outside of the object (the bottom of the left column
in the menu). The left column also provides two- and
three-pixel thicknesses outside the object. The right
column provides one-, two, and three-pixel thicknesses
inside the object. The option in the lower center of the
menu is the null {invisible) border. The fill patterns in
the pop-up menu are for illustration only and do not
affect the fili pattern in the object. See the illustration in
Section 2.

F_ Selects a border thickness for any boxed object but a
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GEM RCS MENU

COMMANDS

Note: Commands are disabled (dimmed) when choosing them is not
meaningful in the present context of GEM RCS. For example, the Edit

Menu commands

(Cut, Copy, Paste, and Delete) are disabled when no

tree or object is setected.

iiew A

Open.., M0
Merge... AN
..IOI'.IIHI..II'C
Close AG

Save

Save fis,.. A

fibandon M
--nm_wl--nuuubud

Quit A

New Clears the view window sc you can start a new
resource file.

Open... At the root level only, and with no tree icon
salected, displays the Iitem Selector so you can
open an existing resource file.

It you have a tree or object currently selected in the
view window, this command opens that tree or
object.

Merge... Disptays the item Selector so you can select an

existing resource file to merge with the one on
which you are working. _

Merging resource files can produce name conflicts.
If the merged file contains names already used in
the current file, GEM RCS creates new names for
the duplicates. (Printing the H or | file is a good
way to check for duplicates--see the OQutput..
command in the Global Menu.)
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Close

Save

Save As..

Abandon

Quit

Closes the current resource file or tree. Closing a
tile clears it from the screen. (If you have not
saved your current edits, GEM RCS displays a dialog
asking whether to save or abandon them See the
note beiow.) Closing a tree returns you to the root
level of the file. Clicking on the close box has the
same effact as choosing this command.

Saves your current resource fila. The file remains in
your workspace sO you can continue editing. Use
this command periodically so you won't lose all of
your work 10 a power failure or computer
malfunction. '

Saves your current resource file under a name you
provide. Use this command in either of the
following situations:

® To name and save a resource file for the first
time. ’

® To save an edited version of an existing file under
a new name and/or to a different directory. The
new directory path and/or,’ﬁlename appear in the
title bar. The original version of the file remains
on disk under the old name.

Abandons all edits on the current file since the last
time it was saved.

Stops GEM RCS and returns you to the GEM -
Deasktop.

Note: If you edit a new Qr existing resource file and then choose the
New, Open... Close, Abandon, or Quit command without first saving
your edits, GEM RCS displays a dialog that asks if you want to
abandon your edits. The dialog's three exit buttons offer you these

options:

® Abandon the edits.

® Save the file.

® Cancel the requested command
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Hutputu..

Hide Parts
Hide Tools

Protection...
Save Preferences 4R

0 0 0000000 0000 00000 0 -0 000000 0 0 01O O

0
)

‘P
il

Qutput...

Protection...

Selects the types of output files (in addition to the
RSC and .DFN files) GEM RCS creates when you
save resource files. You can select inctude files for
C (the default), Pascal, BASIC, and FORTRAN-77, as
well as a .RSH source fite for use with RSCREATE
(see Section 4).

.Sets the level of protection GEM RCS applies while

you are editing resource files. This command has
the following options: ' ’

® LOCKED - Permits editing and sizing but forbids
changes to the tree structure. This setting is
intended for post-production changes, such as
translating strings for internationalization of your
program. Values associated with tree and object
names are preserved; you need not recompile the
application after editing.

® NORMAL - The default protection level. It warns
you before rearranging trees. NORMAL permits all
operations but warns you of impending changes
in parent-child relationships and workspace
clearance.

@ EXPERT - Gives you no warnings. You can make
whatever changes you wish to the resource file.
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Save Preferences Makes the settings and seiections in the output and

Hide Parts

Hide Tools
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protection dialogs the defauits for subsequent GEM
RCS sessions; saves them to a file called RCS.INF in
the GEMAPPS folder. To restore the original
defaults, delete RCS.INF.

Hides the parts box on your screen. The command
toggies between Hide Parts and Show Parts.

Hides the toolkit on your screen. The command
toggies between Hide Tools and Show Tools.
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GEM RCS Menu Commands

ut
Copy 114
Paste A

A 00 00 00 O 0

Delete 4D

Cut

Copy

Paste

Delete

Cuts the currently setected tree or abject to the
clipboard. The original no tonger appears in view
window.

Copies the cdrrentlv selected tree aor object to the
clipboard. The original remains in view window.

tets you move a tree or object from the clipboard
to the view window by dragging from the Edit
Menu. (Use when toolkit is not visible.)

Deletes the selected

objects.

tree, object, or group of
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n OIIO
Nawe. ..
Type...

Load. ..

info...

Name..

Type..

Load...

3-28

Shows you information about the current file or the
currently selected tree or object. Also shows how
much of your workspace you have used and how
much you still have available.

Displays a dialog you can use to name or rename
an object tree.

Dispiays a dialog you can use to change a tree or
object’s type.

Displays the ltem Selector so you can replace an
IMAGE or ICON object with one created using GEM
lconEdit.
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1laren... ¢F

Unhlde Children 4l

0000 00 00 OO IO 000 O 00 000 00000000 OO0 00000 000

Remove Parent

Sort Children...

Unhide Children

Remove Parent

Displ. ;s a dialog in which you can specify how
objects should be sorted within their parent
Sorting causes the objects in the tree to be drawn
in a logical order. Without sorting, the objects in
the trea are drawn in the order in which they were
added to it. This has no effect on the functionality
of the tree, but it can be visually displeasing,

Causes any hidden children of the currently selected
object to be displayed.

Removes the currently selected object without
removing its children. (Dragging an object to the
trash also removes its children.)

Note: Resorting children after your application has been compiled can
renumber the objects in your tree, causing any references to them in
the program code to be incorrect. (You can check this by iooking at
the .H file created by GEM RCS) If incorrect references exist, the
program code must be recompiled.
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DUt ' ¥R
§0 00 0 000 000 0 00 0 4o 0 000 00 400 - 4]
Desk Accessory
Desk Accessory
Desk Accessory
Desk Accessory
Desk Accessory
Desk Accessory

About GEM RCS.. Displays a dialog showing information about GEM
RCS. including the version number, copyright, and
authors’ names.

Desk accessories Names of desk accessories currently available on
your system. The menu can display up to six desk
accessory namaes.

KEVSTROKE EQUIVALENTS OF MENU COMMANDS

Most of the GEM RCS commands can be executed by clicking on the
command in the menu or by typing a keystroke combination. The
following table lists the commands in the order they appear in the
menus and gives their keystroke equivalents.

Note: A command's keystroke egquivalent is only enabled if the
command itself is enabited.
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Keystroke Equivalents

Table 3-4. Keystroke Equivalents of Menu Commands

Keystroke
Command Equivalent Menu
New Ctri-w File
Open... Ctri-0 File
Merge... Ctri-N File
Close Ctri-C File
Save Ctri-v File
Save as... Ctri-M File
Abandon Ctri-A Fila
Quit Ctri-Q Fite ' ""
QOutput... Alt-0 Global
Protection... Alt-§ Global
Save Preferences Alt-R Global-
Hide/Show Parts Alt-pP Global -
Hide/Show Tools Alt-H Global .
Cut Alt-C Edit
Copy Alt-Y gdit -
Paste Alt-A Edit
Delete Alt-D Edit
Into... Alt-1 Options
Name... Alt-N Options
Type... Alt-T QOptions
Load... Alt-L Options
Sort Children... Alt-F Hierarchy
Unhide Children Alt-U Hierarchy

End of Section 3
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Section 4

RSCREATE and Other
Technical Information

USING RSCREATE

RSCREATE is a C language utility program that creates a resource file.
it is primarily intended for two purposes:

® To create a resource file from a hand-edited file.
® To port resource files between microprocessor environments.

RSCREATE uses a .RSH file {described next) as an include file. To
generate a new .RSC file with RSCREATE, include the .RSH file in
RSCREATE.C and compile, link, and run RSCREATE.

RSH File

The .RSH file, which is an ASCIl fite you can edit with a text editor or
word processor, is one of the optional GEM RCS output files. To make
GEM RCS create a .RSH file, choose the Output.. command from the
Global Menu, and click on the box labeled " RSH" in the output file
dialog. You can make the RSH file one of the default set by choosing
the Save Preferences command from the Giobal Menu.  See the
description of the Global Menu in Section 3.

GEM RCS only produces output fites as part of the process of saving a
resource file. For that reason, if you open a resource file solely to
produce 8 .RSH file (in other words, without editing the file), you must
use the Save As.. command and then enter the file’s current name in
the ltem Selector. Because the resource file has not been edited,
closing the file with the Close command or the close box does not
save the file and does not create a .RSH file.
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Hand-Edited Resource Files

To hand-edit a resource file, generate a .RSH file and make your
changes in the .RSH file with a word processor or text editor. Before
you hand-edit a resource file, however, be sure you are familiar with
the material in the GEM_AES Reference Guide describing the Object
Library and the Form Library.

When you hand-edit a .2SH file, remember the following:

® When adding a new object, TEDINFO, etc, insert it at the end of the
currant entries.

® If you insert new objects into existing trees, update the tree base
definitions. '

® GEM RCS expects object trees in the foliowing order:. root first,
followed by its children, left "to right, with the rule applied
recursively. Make sure you enter any hand-built trees in this same
order.

® |f you are creating a resource file with GEM RCS and you expect to
hand-edit the file later, don't enter any object names while you're in
GEM RCS. Wait until you've edited the .RSH file and have run it
through RSCREATE. Then read the new .RSC file back into GEM RCS
and enter the object names. B

if you enter object names in your first pass through GEM RCS, the
.H and .DFN filas are linked to the object numbers assigned in that
first pass. RSCREATE changes these objact numbers, and GEM RCS
will not be able to use the .DFN file for any subsequent work on the
resource file. .

® GEM RCS automatically sets the LASTOB flag in the OBJECT
structure of the last object in each tree. (See the descriptions of
the OBJECT structure and object fiags in Section 6 of the GEM AES
Reference Guide.) If you hand-edit a tree, make sure this flag is set
for the last object in the tree If you don’t. your application can
crash at run-time.
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Porting Resource Files

To port a resource file from one environment to another, do the
following:

1. Move the .RSH file to the new environment.

2. Add a header to make the .RSH file compatible with the target
environment. If you are porting to a 68K environment, the header is
comment~~ out in RSCREATE.

3. Enter the target-format .RSH as an inciude file in RSCREATE.

4 Cc;mpile, Iink; and execute RSCREATE on the target environment.

Compiler Notes

Compile RSCREATE with Lattice™ C or another full fanguage
implementation.

Some C compilers (including Lattice C) fold duplicate strings together
when you compile RSCREATE. This can present problems at run-time
if the strings are to be edited. in that case, run the resource file
through GEM RCS again to resoive the duplicate strings.

CHAINING RESOURCES

The GEM AES enforces an absolute limit of 64K for a resource file. If
you need a larger resource, you can chain two resource files together.
However, to use the second file in the chain, you must first ctear from
the AES any refergnces to the first resource file, and you must clear
the first file from memory by making a RSRC_FREE call before you load
the-second file.

UNKNOWN OBJECT TREE TYPES

It you load a resource file and do not have its .DFN file, GEM RCS
displays each tree as an UNKNOWN ({represented by a question mark)
or an ALERT. Before you can work on the file, you must convert the
unknown trees to one of the known types. You should also give each
tree a name for the .DFN file you will create when you save the file.

il Bl
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To assign types and names to the trees, do the following:
1. Click on the first UNKNOWN (TREE1) to select it.

2. Disptay the Options Menu, choose the Type.. command, and select
the DIALOG option. This replaces the guestion mark icon with the
DIALOG icon.

3. Double~click on the TREE] icon. This opens the tree, and you cén
then see what it is.

It the tree really is a dialog, do the following:

1. Close the tree to return to the root level.
2. Choose the Name... command from the Options Menu.
3. Give the tree a name.

If the tree is not a dialog, do the tollowing:

1. Close the tree to return to the root level.

2. Choose the Type.. command from the Options Menu.
3. Select the correct type for the tree.

4. Choose the Name... command from the Options Menu.
5. Give the tree a name.

For the ALERT trees, you need only open them to see what their
massages are and then use the Name.. command to give them names.

Using the Type.. command from the Options Menu, you can change
the type designation of any tree or object. Remember that MENU and
ALERT trees are quite restrictive; they accept only specific objects that
are for the most part not compatible with other object trees. You can
change a tree’s type from a restrictive type to a less restrictive type
(for example, from ALERT to DIALOG). but you should not try to go
from less restrictive to more restrictive. To do so can produce
unpredictable rasults.

ARRANGING AND ALIGNING OBJECTS

Especially in a dialog, you might want to have several objects arranged
in a particular way. For example, you might want three or four text
strings to appear in a right-aligned column. To do this, you can first
arrange them inside a box, as follows:




GEM Resqurce Construction Set Arranging and Aligning Objects

1. Drag a box from the parts box to the view window. Make the box
the size you want.

2. Add the STRING objects 10 the box and edit them.
3. Select all of the strings in the box using the Shift-click technique.

4. Display the alignment pop-up menu and choose the alignment you
want. (As long as the strings are inside their parent box, you can
also move them as a group.)

5. Select the parent box and then choose the Remove Parent
command from the Hierarchy Menu.  Removing the parent box
reduces the size of both the tree and the resource file

CREATING A LIBRARY FILE

If you use certain icons, bit images, or subtrees frequently, you can
collect them in a “library” resource file. Using the Merge... command
(File Menu), you can read this library file into your current resource
file. You can then use the trash can or clipboard to cut any
extraneous objects fram the resource file. '

End of Section 4







Index

.DEF file

changing to .DFN, 2-14
DFN file, 2-14
H file, 2-15, 3-29
ICN file extension, 3-13
.RSC_file, 2-14
.RSC file extension, 1-5
.RSH file, 2-15, 4-1 "

A

Abandon command, 3-24
About GEM RCS... command,
3-30

Adding object to trees, 3-9
ALERT trees, 1-3, 3-6, 3-10, 4-4
Alerts

format, 1-3
Alignment menu, 2-6
Alt key

symbol in menus, 2-5
Aspect ratio, 3-1
Attributas

Checked, 3-21

Crossad, 3-22

Default, 2-12, 3-21

Disabied, 3-22

Editable, 3-21

Exit, 2-12, 3-21

Hidden, 3-21

Qutline, 3-21

Radio Button, 2-10, 3-21
Selectable, 3-21
Selected, 2-1%, 3-22
Shadowed, 3-21
Touchexit, 3-21

Attributes menu, 2-10, 3-20

Bit image objects, 3-16
aspect ratio differences, 3-1
loading, 3-13

Box type objects, 3-15

C

‘Character snap, 1-3, 3-20

Checked attribute, 3-21
Chitdren, -2

levels, 2-13

sorting, 3-29
Clipboard, 4-5

using, 3-17
Close box, 1-6, 3-24
Close command, 1-6, 3-24
Closing objects, 1-6
Closing resourcae files, 1-6
Closing trees, 2-14
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Commands
editing in MENU tree, 2-5
keystroke equivalents, 3-30
sizing in menu box, 2-6
Campilers, 4-3
Context-sensitive commands,
1-3, 3-13
Copy command, 3-17, 3-27
Creating a dialog box, 2-7
Creating a menu, 2-1
Crossed attribute, 3-22
Ctrl key
symbol in menus, 2-5
Ctri-click, 2-12, 2-13
Ctri-drag, 2-12, 3-3
Cut command, 3-17, 3-27

D

Default attribute, 3-21
Default button, 2-12
Delete command, 1-9, 3-27
Deleting objects, 3-10
Deleting trees/objects, 1-8
Desk accessories, 3-4, 3-30
Desk Menu, 3-10

name variations, 3-3

placeholder commands, 3-3
Dialog box

creating, 2-7
DIALOG trees, 1-3, 3-5
Disabled attribute, 3-22
Duplicate -strings, 4-3
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E

Edit Bit lmage Object dialog,
3-16

Edit Box Type Object dialog,

3-15

Edit Formatted Text Object
dialog, 3-15

Edit Icon Object dialog, 3-16

Edit Menu, 3-27

Edit Unformatted String Object
dialog, 2-3, 3-15

Editable attribute, 3-21

ENTRY objects, 2-3, 3-4

editing, 2-4

Exit attribute, 3-21

Exit buttons, 2-12

EXPERT protection setting, 3-25

Extent, 1-7

F

Fila Menu, 3-23
adding commands, 3-3°

Fill Horizontal, 2-6, 3-20

Fill Vertical, 3-20

Formatted text objects, 3-8,
3-15

FREE image objects, 3-7, 3-14

FREE trees, 1-3, 3-7, 3-13

Free-string objects, 1-3, 3-7,
3-13




G L
GEM AES, 4-3 LASTOB flag, 4-2
GEM Graph, 3-5 Levels
GEM Iconkdit, 3-28 object level, 1-5
GEM RCS root level, 1-5
lavels, 1-5 Library file, 4-5
memory use, 1-9 Load.. command, 3-12, 3-13,
quitting, 2-15 3-16, 3-28
starting, 2-: Loading bit images, 3-13
wdrkspace, 1-9 Loading icons, 3-12
Global Menu, 3-25 LOCKED protection setting, 3-25
H M
Hidden attribute, 3-21 Menu bar, 1-5
Hide Parts command, 3-26 Menu box '
Hide Tools command, 3-26 sizing, 2-4, 2-6

Hierarchy Menu, 2-13, 3-28
Menu/atert buffer, 1-3

MENU trees, 1-2, 3-4, 3-10, 4-4

Menus
| adding ENTRY, 2-4
, adding TITLE, 2-3

lcon objects, 3-16 command conventions, 2-5

aspect ratio differences, 3-1 copying an ENTRY, 2-4

loading, 3-12 creating, 2-1
Include files, 2-15, 3-25 keystroke equivatents, 2-5
Info.. command, 1-9, 3-28 sizing command extent, 2-6
Item Selector, 2-14 sizing menu box, 2-4, 2-6

sorting, 2-7

K symbois for Ctrl and Alt keys,

2-5
Keystroke equivalents, 2-5

Mouse techniques, 1-7

Merge.. command, 3-23, 4-5
Message line {ALERT trees}), 3-6
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Name... command, 3-28, 4-4
Naming objects, 2-8
New command, 3-23, 4-8
NORMAL protaction setting,
3-25
NOTE icon, 3-6
replacing. 3-10

0

Ob_spec vaiue, 3-15
Object level, 1-5
Object namas, 2-9, 4-2
Object trees
See "Trees”
Object types
G_BOX, 3-5
G_BOXCHAR, 3-5, 3-15
G_BOXTEXT, 3-5, 3-15
G_BUTTON, 3-5
G_FBOXTEXT, 3-5, 3-15
G_FTEXT, 3-5, 3-15
G_I1BOX, 3-%
G_ICON, 3-6
G_IMAGE, 3-6
G_STRING, 3-5
G_TEXT, 3-5, 3~15
Objects, 1-2
adding to dialog, 2-8
adding to trees, 2-8, 3-9
aligning, 3-20
arranging/aligning, 4-4
background color, 3-19
border color, 3-22
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border thickness, 3-22

box for user-defined objects
(MENU trees), 2-3, 3-4

changing type, 4-4

children, 1-2

classes, 3-7

closing, 1-6

copying, 1-7, 2-4, 2-9, 3-10

copying trom clipboard, 3-17

copying to clipboard, 3-17

deleting, 1-8, 3-11

drawing order, 2-13

editing text in, 2-9

till pattern, 3-19

icons in parts box, 3-4

in ALERY trees, 3-6

in DIALOG trees, 3-5

in FREE trees, 3-7

in MENU trees, 3-4

in PANEL trees, 3-5

LASTOB flag, 4-2

levels, 2-13

library file, 4-5

moving, 1-7

moving as a group, 4-4

moving from clipboard, 3-17

moving to clipboard, 3-17

naming, 2-9, 3-14

opening, 1-7

order in trees, 4-2

parent-child size relationship,
3-1

parents, 1-2

radio buttons, 2-10

selecting, 1-7

sizing, 1-8, 2-9, 3-11, 3-20

sorting, 2-7, 2-13, 3-29




Open... command, 3-23, 4-8
Options Menu, 3-28

Qutline attribute, 3-21
OQutput.. command, 3-25, 4-1

P

PANEL trees, 1-3, 3-5

using character snap, 3-20
Parent-child size relationship,

3-1

Parents, 1-2

copying, 1-7

moving, 1-7, 2-12

selecting, 1-7, 2-12, 2-13
Parts box, 1-6, 3-4
Paste command, 3-17, 3-27
Pop~up menus, 2-10, 3-19
Porting resource files, 4-2
Protection settings, 3-25
Protection.. command, 3-25
PTEXT field, 3-15
PTMPLT field, 3-15
PVALID field, 3-15

Q

Quit command, 2-15, 3-24
Quitting GEM RCS, 2-15%

Radio buttons, 2-10, 3-21
parent boxes, 2-11
RCS Menu, 3-30

RCS.APP, 2-1
RCS.INF, 3-26
Remove Children command,
3-29
Remove Parent command, 4-4
Replace mode, 3-20
Resource files
chaining, 4-3
closing, 1-6
fite extension, 1-5
filenames, 1-5
hand-editing, 4-1
porting, 4-2
saving, 2-14
Resources, 1-2
Root tevel, 1-5
RSCREATE, 4-1
generating resource file, 4-1
RSRC_FREE, 4-3

S

Save As.. command, 1-9, 2-14,
3-24

Save command, 1-9, 3-24

Save Preferences command,
3-26

Saving resource files, 2-14

Screen resolution, 3-1

Scroll bars, 1-6

Selectable attribute, 3-21

Selected attribute, 2-11, 3-22

Separator line, 2-3, 3-4

extending, 2-6
Shadowed attribute, 3-21
Show Parts command, 3-26
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Show Yaols command, 3-26

Size handle, 1-8, 2-8, 2-13

Sliders, 1-6

Sort Children.. command, 2-13,

3-29

Sorting objects, 2-7, 2-13, 3-29
options, 2-13

Starting GEM RCS, 2-1

STOP icon, 3-7

T

TEDINFO structure, 3-15
Text objects
aligning, 3-19
background, 3-19
cotor, 3-19
sizing, 3-19
Tilde character, 3-15
Title bar, 1-5
TITLE objects, 2-3, 3-4
Toolkit, 1-6
using, 3-18
Tools
description, 3-19
TOOLS folder, 2-1
Touchexit attribute, 3-21
Transparent mode, 3-20
Trash can, 1-8, 3-10
Trees, 1-2
assigning types and namaes,
4-3
changing type, 4-4
choosing icon, 2-8
closing, 2-14
copying, 1-7
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deleting, 1-8
moving. -7
naming. 2-8
opening, 1-7, 2-8
restrictive types, 4-4
selecting, 1-7
Type.. command, 3-28, 4-3, 4-4

U

Unformatted string objects, 3-8,
3-15

Unhide Children command.
3-29

UNKNOWN trees, 4-3

Using the clipboard, 3-17

Using the tooikit, 3-18

v

Validation characters, 3-16
View window, 1-6

w

WAIT icon, 3-6

Workspace, 1-9
rastoring, 1-9
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